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Tutorial 2: Introduction to ArcGIS and the geomorphology of Maui 
 
Objectives 
In this lab you will: 1) Learn the basics of the software package we will be using for the remainder of the 
semester, and 2) Discover the role that climate and geologic history play in controlling the morphology of 
volcanic islands. 
 

 
Figure 1: Hawaiian Government Map of Maui, 1885 

 
Background 
For much of the 20th century, quantitative analysis of landscapes involved paper maps constructed from 
painstaking field surveys (like in Fig. 1 above), and later supplemented with aerial photographs. With the 
explosion of personal computers and satellite-based remote sensing, a new very powerful tool, the 
geographic information system (GIS), has emerged. The power of GIS comes from the integration of 
visualization, analysis, and database management of geospatial datasets, with applications ranging from 
geologic mapping to municipal planning to epidemiology. In this lab you will learn the basics of ArcGIS, 
a popular commercial software package that we will be using in a more rigorous manner for later labs.  
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2.0 Opening a file geodatabase and adding data sets 
For this tutorial, make a folder called “Tutorial_2” or something similar, and download/extract 
the zipped lab data from Angel here. Next, right click on “tutorial_2_data.gdb” and select Make 
Default Geodatabase. 
 
The four datasets given to you are summarized below: 

 
File name Data type Grid size Description Source 

maui30_dem Raster     30 m Digital elevation model 
(m) 

USGS National Elevation Dataset 
http://viewer.nationalmap.gov/viewer/ 

maui_annual_rainfall_grid Raster     250 m 1978-2007 Interpolated 
mean annual rainfall (mm) 

UH Rainfall Atlas of Hawai’i 2011 
http://rainfall.geography.hawaii.edu/downloads.html 

maui_rainfall_data.shp Point shapefile    .   - Rainfall station data UH Rainfall Atlas of Hawai’i 2011 
http://rainfall.geography.hawaii.edu/downloads.html 

maui_geology.shp Polygon shapefile      .      - Geological units USGS Geologic Map of Hawai’i 2007 
http://pubs.usgs.gov/of/2007/1089/ 

 
To load these into your current project, simply drag and drop the four icons into the main 
window. Alternatively, you can click on the Add Data icon  on the Standard toolbar and add 
datasets individually. 
 
If you are having trouble at this point, see Tutorial 1, Section 1.2 and 1.3 for help. 
 

2.1 Visualizing data 
You should now see the four datasets in the table of contents under the Data Frame “Layers”. A 
Data Frame is a map element that defines the geographic context and display properties for one 
or more layers or datasets in ArcMap. Right click on the Data Frame “Layers” and select 
Properties (Fig. 2). Here you can rename the Data Frame, change the coordinate system and 
display units, and control how the Data Frame is displayed in Layout View (see section 1.6). 
 

 
Figure 2. Data Frame Properties dialog box. 
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Now double-click the layer “maui30_dem” to bring up the Layer Properties window (Fig. 3). 
Here you can control the Symbology for each layer – that is, how the data are displayed in the 
main window. You can color code using different color ramps, and choose how you map the data 
to the color ramp by adjusting the Stretch. You can also assign specific colors to ranges of values 
by using a Classified symbology. You can also control the transparency of each layer in the 
Display tab of the “Properties” window. Experiment a bit here! 
 

 
Figure 3. Layer properties window (raster dataset) 

 
Next, open the properties window of the layer “maui_rainfall_data”, and go to the Symbology tab 
(Fig. 4). Here you can choose which symbol to use, and vary the color and/or size of the symbols 
according to various attributes in the Attribute Table. For example, you can color-code the 
rainfall stations by mean annual rainfall in millimeters (the field “AnnAvgMM”). To aid in 
legend readability, it is a good idea to simplify the labels (Fig. 4). 

 

 
Figure 4. Layer properties window for Maui rainfall data, showing the Labels being edited for clarity. 
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You can change the symbol and size by clicking Symbol and then Properties for all symbols…, 
and you can change the numerical classification scheme by clicking on Classify, which also 
presents some basic summary statistics for the dataset (Fig. 5). 
 

 
Figure 5. Classification window for Maui rainfall data feature class symbology 

 
Experiment a bit to get the feel of displaying different attributes of the shapefiles. If you want to 
see the actual database behind the shapefile, right click on the layer and select Open Attribute 
Table. You can think of this as an Excel data table where each row corresponds to a specific 
geometric shape and location on the map. In the case of the “maui_rainfall_data” layer, this 
geometry is simply a point with x,y coordinates. For the “maui_geology” layer, each row 
corresponds to a polygon outline of a geologic unit on the map. This connection between 
databases and geographical information is at the core of why Geographic Information Systems 
(GIS) are so powerful! 

 
2.2 Exploring data: 

Take some time to explore your data a bit. You can zoom in and pan around with your mouse, 
and if you get lost, click the little blue globe on the Tools toolbar to get you back to the maximum 
extent (Fig. 6). The Ruler icon       allows you measure distances, perimeters, and areas, which 
are displayed using the units defined in the Data Frame properties. Also on the Tools toolbar is 
the Info icon       that will give you layer information where clicked. You can spot-check an 
elevation, get the info from a geologic map, etc. Experiment! 

 

 
Figure 6. “Tools” toolbar. 

 
 
One incredibly helpful tool is the Profile Graph tool on the 3D Analyst toolbar (Fig. 7). This 
allows you to extract the information of a raster dataset along a linear or segmented profile. 
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Figure 7. 3D Analyst Toolbar and the interpolate line tool. 

 
First, select the raster dataset you wish to draw a profile of (here we’ll use the DEM). To draw 
your line, use the Interpolate Line button and start clicking out a path. Double click the last 
point to finish, and then select Profile Graph to plot your profile. It will look something like Fig. 
8 below: 

 

 
Figure 8. Profile graph of elevation, showing vertical exaggeration and location of cross section. 
 
Note that the y-axis here shows elevation in meters, and the x-axis shows distance in meters. Be 
sure to note the vertical exaggeration on your plot, which is simply the ratio of the horizontal 
scale to the vertical scale. Using Fig. 8 as an example, 1” corresponds to 3,000 m on the 
horizontal axis, but only 1,000 m on the vertical axis, thus the vertical exaggeration is 3x. 
Unfortunately, there is no clean way to set the vertical exaggeration of your chart, so you will 
have to determine this manually or eyeball it. 
 
A common pitfall is to accidentally plot a profile of a different raster, such as the mean rainfall, 
slope, or hillshade. Use common sense, and if something looks weird (like elevations ranging 
from 0-70), you probably made a mistake somewhere! 
 
You can edit the axes, labels, etc. by right clicking anywhere on the chart and choosing 
Properties (Fig. 9). At a minimum, you must label all of your axes (including units) and indicate 
vertical exaggeration. For aesthetics, I would also remove the grey background and any 
unnecessary outlines or distracting grids. Neat and tidy graphic design is an underrated 
component of scientific communication! 
 

Interpolate Line 
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Figure 9. Profile graph appearance properties 

 
You can export the finished plot by right clicking and choosing Export… and then saving as a 
PDF (Fig. 10). It is also possible to right click the graph, select Copy as Graphic, and then paste 
the graph into your map in Layout View (see section 1.6). There are some minor annoyances that 
may arise with automatic resizing, so be aware and find a method that works to your liking. 

 

 
Figure 10. Export dialog for profile graph. 
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In the Export dialog box you can also export the raw x-y data by clicking on the Data tab. This is 
helpful if you would like to use another program like Excel to plot and manage your profile data. 
If you want to redo the profile, you can delete the line on the map after selecting it with the black 
selection arrow on the Tools toolbar (Fig. 6). 
 
If you would like to save your profile line as a feature class, first select the line graphic, then go 
to the drop-down menu on the Drawing toolbar and run the tool Convert Graphics To 
Features… This is not necessary for this lab assignment, but may come in handy later in the 
semester. 

 
2.3 Using GIS tools to perform calculations and generate new data sets 

To visualize our digital elevation model, it is helpful to make a hillshade of the topography. A 
hillshade is a simulation of incident sunlight intensity on the surface defined by the digital 
elevation model. 
 
Go to the ArcToobox window and double click on \\Spatial Analyst Tools\Surface\Hillshade 
(Fig. 11). We want to make a hillshade of the layer maui30_dem, so select this from the pull 
down menu Input Raster. For the Output Raster, we’ll save to the same folder, and give it the 
name maui30_hillshade. 

 

 
Figure 11. ArcToolbox window and the Hillshade tool graphical user interface 
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Another common task for geomorphologists is the make a slope map. Double click on \\Spatial 
Analyst Tools\Surface\Slope (Fig. 12). We’ll stick with units of Degrees rather than 
Percent_Rise for now. 

 

 
Figure 12. Slope tool dialog box. 

 
The final calculation we will perform is to generate a contour map of mean annual rainfall from 
the dataset “maui_annual_rainfall_grid”. Navigate to and double click on \\Spatial Analyst 
Tools\Surface\Contour (Fig. 13). We can start with a contour interval of 1000 mm, but you can 
experiment to find the most appropriate interval. 

 

 
Figure 13. Contour tool dialog box. 

 
**Note that if you screw up and make a layer you don’t want, you can remove it from the Table 
of Contents by right clicking and selecting Remove, and then delete the actual file in the 
Catalog. DO NOT try to delete individual files in Windows explorer. 

 
2.4 Making a map 

Now that we have loaded and generated some layers, we want to present them in both an 
informative and visually appealing manner. Take some time first to experiment with symbology, 
the layer order, which layers are visible, and the transparency levels. Decide on what you want to 
show/emphasize, and then cut the fluff. Once you have a nice looking map, switch to layout view 
by choosing Layout View from the drop down menu View. This is essentially a print preview, 
and what you see is what you get. 
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To pan around in layout view, use the zoom and pan tools in the Layout Toolbar (Fig. 14).  
 

 
Figure 14. Layout Toolbar 

 
If you want to move the map around within the data frame, you can use the pan/zoom tools in the 
Tools Toolbar (Fig. 6). If you want to save an extent so you can zoom quickly back to it, you can 
bookmark it by selecting Create Bookmark… from the Bookmark pull down menu. 
 
You can insert various graphics elements such as scale bars, north arrows, legends, and text 
annotations. Some of these are accessible from the Insert menu, and others are found on the 
Draw toolbar. When you print your maps to turn in, make sure to always include a title, scale 
bar, north arrow, and an appropriate legend, including units. 
 
I expect these to be publication quality, and will show you a few examples in class of what I 
mean by this. In general, it is good practice to ask yourself whether someone unfamiliar with this 
week’s tutorial would be able to understand everything on your map. 
 
Some tips: 

• Make sure to label everything and indicate the units of measurement for each layer. 
• Eliminate unnecessary “chart junk”, such as incomprehensible layer names and generic 

titles like “Legend”. 
• To change the color or thickness of your cross section lines, double click on the map in 

Layout View to Focus the Data Frame. This enables you to select and edit graphics 
items that were created in Data View. 

• Annotate all of your cross section lines with A-A’ or similar. 
• Be sure that your map scale bar shows analogous units to your cross sections. 
• Make sure to scale the size of your text and labels appropriately, so that they are readable 

when the map is displayed in full. 
 
For this week’s lab, the map of Maui is going to fit better in Landscape orientation than in 
Portrait. To change this, select Page and Print Setup from the File menu, and select Landscape 
orientation (Fig. 15). 
 
This semester, you will be handing in digital copies of your labs as .pdf’s rather than printing 
them out. To export your map from layout view, select Export from the File menu (Fig. 16). Set 
the resolution to 300 dpi, and give it a helpful file name like “Tutorial_2_Figure_1_lastname.pdf” 
 
For now, exit out of layout view by selecting Data View from the drop down menu View. 
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Figure 15. Page and Print Setup 

 

 
Figure 16. Export dialog 

 
2.5 Saving your workspace 

To save your mapping workspace, select Save as… from the File pull down menu. These 
workspaces are saved as .mxd files. It is important to note that .mxd files simply point to the 
original datasets, and are used to save the layer orders, transparencies, symbology, and layout. 
Thus, I highly suggest keeping a different .mxd file for each map you turn in. 
 
If you want to open your .mxd file on a different computer, or if you move your folders around, it 
is important to first go to File/Map Document Properties, and check the box next to Store 
relative pathnames to data sources. 
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2.6 3D Visualization of data in ArcScene (OPTIONAL) 
Often times, it is helpful to view a 3D rendering of the landscape, as when you use Google Earth. 
The program ArcScene enables you to directly load custom image and elevation datasets that you 
have generated in ArcMap in a much more flexible manner than Google Earth.  

First, open up the program ArcScene using the shortcut on the 3D Analyst toolbar: . The layout 
looks quite similar to ArcMap, and you have access to the same tools and catalog. Open the 
catalog window, navigate to the raster dataset “maui30_dem”, and load it into your map window. 
Right now it is a flat plane that you can rotate and move around using various mouse buttons. 

To make this layer 3D, we need to assign base heights. Double click on the layer and go to the 
Base Heights tab (Fig. 17). 

 
Figure 17. Assigning base heights in ArcScene. 

 
We want to assign the elevation values from “maui30_dem”, so select Floating on a custom 
surface and then navigate to the raster “maui30_dem” if it is not already selected. We can also 
control the resolution of the base height assignment. Our data set has a Cell size of 30 m, but to 
make visualization smoother on slow machines, set the values for Cellsize X and Cellsize Y to 
60. You can increase or decrease this number to enable faster 3D rendering or see more detail. 
You can also adjust vertical exaggeration and offset in this window. Try setting the conversion 
factor to 2.0 and see what happens. 
 
After you adjust the base heights, reset the scene extent by clicking the large globe button on the 
right hand side of the navigation toolbar (Fig. 18) 
 

 
Figure 18. Navigation toolbar in ArcScene. 
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We can add illumination to scene by going to the Rendering tab in the Layer Properties dialog 
and selecting Shade areal features relative to the scene’s light position (Fig. 19). While you 
are here, crank up the slider bar on Quality enhancement for raster images. Similar to choosing 
the base height resolution, this adjusts the image resolution of your raster datasets. If your 
computer is getting bogged down, you can slide this back to the left. 
 

 
Figure 19. Rendering properties for layer in ArcScene. 

 
You should end up with something that looks like Fig. 20. 
 

 
Figure 20. 3d perspective of Maui, shaded by elevation, with 2x vertical exaggeration, viewfield angle = 55°. 
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You can change the perspective and lighting of the scene by opening the View Settings and 
Scene Properties dialog boxes from the View menu (Fig. 21). In View Settings, it is often 
helpful to adjust the Viewfield angle to its lowest value, 1 degree, so as to minimize 
foreshortening (Fig. 22). 
 

     
Figure 21. View Settings and Scene Properties dialog boxes. 

 

 
Figure 22. Same as Fig. 21, but with viewfield angle = 1°. 

 
Often times, it is more useful to visualize a separate dataset, such as a slope map or geologic map 
for this tutorial. Navigate to and load up the dataset “maui30_slope” that you made in Section 2.3 
above, and adjust the symbology to match what you used in ArcMap. Repeat the steps shown 
above to assign base heights using the DEM (Fig. 17), shade the features using the scene’s light 
position, and crank up the quality enhancement for the raster image (Fig. 19). Now you should 
have a nicely-rendered slope map to explore! To save this image, take a screenshot or go to 
File/Export Scene/2D. You can make a high-resolution output by increasing the View size and 
resolution.  
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Tutorial 2 deliverables, due 5:00 pm Friday, February 12 (10 pts total) 
 

Please submit as single PDF file to the Tutorial 2 drop box on Angel 
 
(6 pts) Four maps made in ArcGIS, all of which must have a title, scale bar, north arrow, and 
appropriate legend, including units. 

• A map of Maui showing the elevation partially transparent over the hillshade, and including 
labeled cross section lines for the topographic cross sections below. For this map, the elevation 
(DEM) layer should have a “stretched” symbology. 

• A map or Maui showing slope partially transparent over the hillshade. For this map, the slope 
layer should have a “classified” symbology with appropriately chosen intervals. 

• A map of Maui showing contours of mean annual rainfall, including the station locations – you 
may overlay this on the elevation, hillshade, slope map, or some combination. 

• A map showing the geology of Maui. Again, it may be helpful to overlay this on a hillshade. Be 
sure to choose an appropriate symbology that highlights the most informative contrasts in 
geology across the island. 

 
(2 pts) Two topographic cross sections extracted from the DEM, both of which must have titles, 
labeled axes, and the approximate vertical exaggeration noted. 

• A representative cross section of the east summit that begins and ends at sea level. 
• A representative cross section of the west summit that begins and ends at sea level. 

 
(2 pts) A written report no more than 2 pages long (12 pt font, 1.5 line spacing, 1” margins), which 
should include the following: 

• A brief introduction and description of the datasets used (1 paragraph) 
• A description of the morphology and climate of Maui – be as quantitative as you can (1-2 

paragraphs focused on observations and measurements) 
• A discussion of how climate and the timing of volcanism influence the patterns of erosion on 

Maui (~2 paragraphs focused on interpretations) 
 

You will not need any outside resources for this report. Trust your observations! Below are some 
questions to help motivate the written report: 

What is the elevation of the western summit? What is the elevation of the eastern summit? 
How does rainfall vary with elevation on the western part of the island? On the eastern part? 
How does the depth of river incision vary across the island? 
Where are the oldest basalt flows found on the eastern part of the island? 


